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This Resource Pack was written in order to provide an easy-to-use
guide to engaging young people in creative activities using digital
technology. It is based partly on my own personal experience of
engaging young people from Dublin’s Inner City communities
in creative digital activities as manager of the SWICN Intel
Computer Clubhouse1, and partly on some research I carried
out with Youth Workers who were interested in running creative
workshops using digital media with young people2.
Theories developed below are largely inspired from J.Piaget’s
theories around learning, and from Mitchel Resnick’s
Constructionist theories, used in the Computer Clubhouse
concept3.

Considering That resources to buy equipment may be limited in
many Youth Projects, I have tried to emphasize as much as possible
workshops and activities that can be implemented on a low-
budget.

Why encourage young people to be creative 
through Digital Technology?

A way of relating to young people’s interests
The ubiquity of information and entertainment media in today’s
society means Youth Workers are dealing with a population of
under 20s who were born with television, movies full of special
effects, digitalised music, 3D video games, etc. These can play
an important role in young people’s lives and they generally
constitute a big part of their personal interests. For that reason,
using computers to create artistic projects can relate to them
and to their own interests in a way that is very different from
what traditional craft projects such as glass painting or papier
mache can offer. If a young person is very interested in a foot-
ball team, a band or a video game, they can easily build projects
through digital technology using these interests as a starting
point (e.g. by downloading a picture of a team/band from the
internet and creating a project with it).
Youth Work theories agree that young people are likely to feel more
involved in a project that starts from their own interests, and
the use of digital technology can greatly help the development
of creative projects with young people in that respect.

1 The SWICN Intel Computer Clubhouse is an after-school project
engaging young people with digital media through creative workshops 
and a drop-in.

2 See Questionnaire page 87.
3 See ‘Theory and ideas around young people and digital creativity’ in the 

Resources Section, PART 5.

Increasing young people’s self-confidence
Digital Media also offer an alternative form of expression to
writing and spelling, just as fine arts and music do, but it can do
so in a more complete way, combining in the same project a variety
of tools including internet browsing, digital photography, video,
music, painting, animation, modelling (clay, plasticine), etc.
Digital Media can be a great alternative for young people who
have difficulties reading and spelling, while at the same time
activities like surfing on the internet and writing a card or an
article for a newsletter can be an incentive for young people to
practice reading and spelling in a different way.
From an educational point of view, some projects using computers
can tackle many subjects related to school such as spelling,
mathematics, physics, biology, etc.

An empowering tool for future citizens:
While most of the time young people are consumers of digitalised
information and entertainment, giving them the opportunity
to become creators using the same media can be a strong
empowering tool, for their creativity as well as for their roles as
citizens. Creating through digital media can give young people
greater perspective and distance when watching television or
playing video games, and it can show them how easy it is to
manipulate images for instance.
Allowing young people to become familiar with digital technology
is also a way of preparing them for their future lives, in a world
where using digital media is becoming a requirement for an
increasing number of professional activities.

How can computers be used for creative workshops 
in a Youth Project?

When Youth Projects have computers accessible to young people,
they often use them exclusively to write CVs, search for jobs or
information on the internet, visit chat rooms, type letters or play
games, which can be very useful. When it comes to making a
creative use of computers, a variety of approaches can be used
according to the community in which youth workers are working.
Indeed, possible methods can range from a very loose environment
to a very structured one, and it is up to youth workers to decide
which level of structure or looseness the young people they
work with need.
The timescale can also vary, there is no rigid model for delivery of
creative programmes with computers, as with any other creative
programme it is up to youth workers to adjust activities to the
mood of the day.
However, experience in a Dublin inner city community has led
me to adjust our creative programmes with computers to fit
the following pattern:
- Short-term workshops to introduce a particular software 

(structured)
- Long-term weekly drop-in sessions to allow young people 

who enjoyed the workshops to work on their own projects in 
a more autonomous manner.

INTRODUCTION 2
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1.1. Equipment: what do you need to start creative 
workshops using digital media in your Youth Project?

One computer is enough to start a very creative project, if you
can find the time to design a programme that will allow each
young person in a group to spend enough time using it on a
one-to-one basis. That young person will also need the help of
an adult to get started, but will probably become autonomous
soon enough.

1.1.1. If you don’t have a budget but have access to the internet

You can find a number of free pieces of software on the internet,
that can be downloaded and installed onto your machine easily.
These do not require a licence, so you can install them on all
your computers if you have several. If the computers accessible
to young people are not the ones connected to the internet,
you can copy the files that install the software onto a floppy
disc or burn it onto a CD if there isn’t enough space on the
floppy. A zip drive is another possibility to transfer big files
from one computer to another.

Software downloadable from the Internet

• Squeak4: this software encourages creativity with an educational
aspect to it.
It allows young people to draw an object they like, and then 
to programme it according to what they want the object to do.
The programming aspect tackles a number of mathematical 
notions that can relate to what they do at school too.

• Gamemaker5: this package allows young people to create 
their own video game in 2 dimensions, to design it with pictures 
of themselves if they want, and then to play it with their 
friends. It combines creativity through Digital Technology 
and educational contents through programming. However, it
requires some time training oneself through tutorials available
online, since it is a difficult package.

Website construction:
Geocities pages on Yahoo: Geocities is part of Yahoo, who 
provide an e-mail service like Hotmail. Geocities allows users 
of Yahoo to build their own webpages online for free.
You will first need to create a Yahoo e-mail account for yourself.
Then You will need to create a Geocities account in order to 
start building your website and have access to the online 
tutorials. Both are free.
In order to have a free website, you will have to accept ads 
displayed on your page.

Other possibilities are trial versions of commercial software,
which you can download from the company’s website for free
but which you’re only allowed to use for a number of weeks.
These will allow you to run workshops within the trial period.

4 Please see the Resources Section, PART 5, for more information
5 For more information, see the Resources Section, PART 5

All software listed in the next paragraph has trial versions
available on their websites.
Once these software packages are installed on your computers,
you need to find time to train yourself to use them. Tutorials
can be found on the internet (for examples of tutorials made for
projects involving young people please see the Resources Section,
PART 5).

1.1.2. If you have a budget:

A number of things can be purchased to maximise the creative
possibilities of digital media in your project:
If you have a small budget, the following equipment is recommended,
in order of importance:

• A Digital Still Camera6: these come with a picture editing 
package that allows you to manipulate photographs you 
have taken, making very creative graphic projects.
Most importantly, a camera allows young people to take 
photographs of themselves and to work on images of themselves,
which is often the first thing most of them usually want to 
do when faced with digital equipment.
Digital cameras are especially good with young people who 
need attention, or who are faced with the usual adolescent
identity troubles. Some young people whose photograph has 
never been taken will spend hours taking pictures of them
selves and just looking at their own images.
Others will refuse tohave their picture taken, but with 
encouragement it can be a starting point for a project
around identity, awareness of their bodies and the building 
of self-confidence.
Digital cameras also have the great advantage of allowing 
people to delete pictures they don’t want to keep, so for the 
first time young people can be given full freedom to take as 
many pictures as they want of whatever they wish, and this 
freedom itself can be an important start for a project encouraging 
creativity.

• A Digital Video Camera and video editing software: either a 
‘Hi-8’ Camcorder with little ‘Hi-8’ tapes, or a DV Camera7, the 
latter being more expensive but much easier to work with.
The video editing software is usually not included with the 
video camera. User-friendly editing software like Video 
Factory8 will make it easier for young people to engage and 
create with. Adobe Premiere for PCs is a more professional 
package but can usually only be handled by young people 
over 13.

• Picture editing and graphic creation software: the most common
package for that purpose is Adobe Photoshop, which is used 
by a wide range of people, professionals as well as non-
professionals. It allows for hundreds of possibilities to manipulate 

6 See Glossary
7 See Glossary
7 For more information on software, see the Resources Section, PART 5

PART 1: ORGANIZING SHORT-TERM CREATIVE WORKSHOPS 
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and edit photographs as well as drawings. It can be used on 
its own with a digital camera or with the Internet for a lot of 
workshops. It can also be used to draw pictures, although 
packages like Paint Shop Pro, Adobe Illustrator and Corel 
Painter are more suitable for drawing instead of working 
from existing photographs.

• Creative and Educational games: The Incredible Machines, by 
Sierra, is a very educational game involving contraptions 
where young people learn about logics, physics and mechanics 
at the same time. It has several levels to allow all ages to play.

• Animation software: the most popular software used for 
making animations is Macromedia Flash, which allows for 
the creation of clay animations and cartoons, through the 
animation of drawings and pictures. It can also be used to 
build a website. Other animation software include 
Macromedia Director. However, both software are used at a 
professional level and they can be difficult to use.

• Publishing software:
Website construction: the most popular software for that
purpose is Macromedia Dreamweaver, which allows you to 
create a webpage, where text and pictures can be inserted 
very easily.
Microsoft Publisher is an easier tool for designing web pages,
although it is more limited.

Newsletters: The following software allows you to design 
Newsletters that can be printed out or posted onto the internet.
They offer a number of templates that can be useful for new 
users.
for under 12s: Microsoft Creative Writer 2
for over 12s: Microsoft Publisher allows you to create newsletters,
business cards and all sorts of publications, as well as webpages.

1.1.3. Getting an Internet Connection and using it
with young people:

The first thing to have in mind when giving young people
access to the internet is the amazing range of possibilities for
research, pictures, information, etc.. However, it is important to
also keep in mind the danger of pornographic websites and
pop-ups (little windows that automatically pop-up on your
screen and can display or be linked to pornographic content), as
well as that of chat rooms.

I would strongly advise that you take four crucial steps to
ensure a safe use of the Internet and young people’s safety as
much as possible:

• Get a Netnanny (a piece of software that will block most
websites with pornographic content): you can download a 
free Netnanny from the Internet or buy one (Net nannies 
work by blocking websites containing  words like “sex”).
However, some pornographic websites manage to get past
these and it is for that reason that the second measure is as 
important, if not more important than this one.

• Insure an adult presence at all times: Make sure a leader is 
always keeping an eye on what young people are looking at.
It is important not to leave young people completely alone 
when they are on the internet, because Netnannies won’t
block chat-rooms or prevent young people from sending 
messages to strangers.

• Educate young people and inform them of your Internet policy:
It is crucial to explain to young people why chat rooms can 
be dangerous and why they shouldn’t give their names,
addresses or anything that can help someone locate them,
instead of just forbidding chat-rooms altogether.
Although it can be your project’s Internet policy to forbid 
chat rooms, explaining why and making them aware of the 
danger remains crucial since young people might have the 
opportunity to go to an Internet café to access chat rooms 
without supervision.

• Get the consent of legal guardians: In a form that states your
Internet policy and the 3 measures mentioned above, you can
ask for legal guardians’ consent regarding young people’s 
access to the Internet, or you could include a tick box on your
consent forms, to indicate that access to the Internet is not
allowed.

PART 1: ORGANIZING SHORT-TERM CREATIVE WORKSHOPS 
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6
EXAMPLE OF A YOUTH PROJECT�S INTERNET POLICY

INTERNET POLICY FOR YOUNG PEOPLE

has installed Netnannies on all the computers accessible to young

people, in order to limit risks of access to pornographic websites.

has a policy of constant supervision when a young person is using the

internet.

has a policy of educating young people about the dangers of the

Internet and especially chat rooms. Thus, young people are told why it is dangerous to post their photographs,

names, addresses, name of school or youth club they attend on the Internet.

has a policy of safety for young people using the Internet, and forbids

chat rooms as well as giving contact details  over the Internet, that could help someone localise or recognise

them : does not allow  photographs, second names, addresses, names of

schools or youth clubs they attend to be given over the Internet while in their premises.

It is ‘s policy to ask for the consent of legal guardians before young people

are given access to the Internet.

For more information on Internet policy, please contact:



1.2. Organizing Creative Workshops Using Digital Technology

1.2.1. Preparation:

Once you have one or more computers and at least one piece
of software, you can start planning your workshop. As for any
activity in a Youth project, planning is essential, to ensure the
success of a workshop.
When working with computers and young people for the first
time, it becomes even more important because usually leaders
don’t know how young people will react to the technology.
A number of things need to be taken into account when
preparing a workshop:

- Needs assessment:

As with most youth activities, it is useful to ask young people
how they would feel about a computer workshop, and if you
have several possible activities, to get them to choose which
they would rather do.
Also, it is important to assess young people’s computer literacy
before starting to plan in detail, by asking them how familiar
they are with computers. Indeed, it may appear that some of
them have never had any contact with computers before, and
might therefore not be able to do the activities you had in mind
(some might also claim computers skills they don’t necessarily
have).

If it turns out that the group shares the same level of computer
literacy, then you can adjust your workshop to that level. If on
the other hand they have very different levels, you can either
design a workshop that will use peer teaching9, or design two
different levels of activity if you feel peer teaching might not
work in that particular group (potential for hostility between
the computer literate and the other young people, lack of self-
confidence by some young people, etc).

- Objectives of the workshop:

Once you have made your needs assessment, you need to
decide on the objectives of the workshop. Asking yourself a
number of questions can help that decision:
• How creative do you want this workshop to be?
• Are you hoping to influence young people’s creativity or 

behaviour through this workshop?
• Do you want young people to engage in a learning process 

with a particular package or with computers in general?
• Do you plan for this workshop to be relevant to young people’s

professional life in the future? ( add the experience to their 
CV or help them get a job for instance)

You might want to do all these things at the same time, but
realistically it might take some time for young people to learn
about digital technology. Even though a creative workshop 
using computers is a very good way of giving young people a 

9 See Glossary

fun and positive image of digital technology, one workshop using
computers can’t be expected to turn anyone into a computer expert.
When planning a creative workshop with digital technology,
the easier it is the better, to allow some space for creativity
alongside the learning process that is involved.
According to the objectives that you have set for your workshop,
you can now plan the logistics of the workshop.

- Logistics:

Duration:
There is no fixed duration for a creative computer workshop, but
6 sessions are usually a good compromise between completing
a digital project and providing young people with something
new at regular intervals.
If possible, it is often best to have 2 sessions a week, since the
learning curve involved in a digital creative project is considerable,
and it might be difficult for young people to remember what
they learnt during the previous session if too much time elapses
between them. Even though the aim of your project might be
pure creativity, using computers will in most cases involve a
learning aspect that can be an obstacle to creativity if it isn’t
handled well and adjusted to young people’s computer literacy.

Ratio: computer / young person:
For that reason, it is also important to plan the use of the
equipment appropriately. However difficult it might be, one
computer per young person is undeniably the best way of giving
young people freedom to be creative (imagine organizing an
art workshop with one paintbrush for every 2 young people).
Although young people working in pairs is usually a great way
of improving creativity and should be encouraged during such
workshops, giving each young person the opportunity to go
back to their own computer and complete their part of the
project is the only way for them to have a personal experience
of technology. The first thing most children ask when coming
to my digital centre for the first time is “can I have my own
computer?”
If you don’t have enough computers or software for each
young person, you might need to design your workshop around
that difficulty, and devise a number of alternatives that will
allow each young person to have a real interaction with the
technology.

- Divide your group into several little groups and plan different
activities for them in the same session. If you’re doing some 
photography or video, you can have a group working on taking 
pictures or shooting a video, while another is on the computers
editing pictures, designing a cover, writing credits, planning 
the end of the film, drawing the story board...
Even when there is one computer per person, this structure is
usually a very successful one with young people when you 
plan that the groups swap in the middle of the session. It
allows young people to change activity every 1/2 an hour and
it gives them the opportunity to create on a variety of tools.

- Work with a smaller group of young people but plan a second 
workshop to allow the rest of the group to do the workshop 
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as well. You can organize an activity on the side like arts and 
craft (the quieter the better to help young people’s concentration 
on the technology). Even though the group who comes second 
might show disappointment at first, knowing that they will 
be able to do the workshop and work on their own computer
is usually a good incentive.

Size of the group:
The ideal size of the group will entirely depend on the number
of youth leaders and especially on the number of leaders who
know the equipment. As said before, the technical and learning
aspect involved in digital workshops can be an obstacle to creativity,
and for that reason it is good to plan according to the computer
literacy of the staff.
Thus, if you have one leader who can handle the equipment
and one who isn’t familiar with it, it is best not to plan for
more than 2 or 3 young people working with the leader who
knows the equipment. According to the group’s behaviour, you
can then plan for the rest to work on an aspect of the project
that won’t require too much help (taking photographs, shooting
a film, helping with ideas for a story...).

Workshops using digital technology are usually more successful
in small groups because young people often need a lot of one-
to-one help at the start, and an ideal size is 1 adult knowing how
to use the equipment for 2 young people. However difficult it
may be to reach this ratio, the success of the workshop will
greatly depend on it. Unless the group is very patient, one adult
running between 4 or 5 young people asking for help could
result in the group expressing frustration, starting to misbehave
and moving on to do something else. Attempting to work with
too many young people, with too little help, often results in an
unfinished project and can be seen as a failure and felt as a
frustrating experience by young people, who were told they
would have a completed project to showcase at the end.

1.2.2. Engaging Young People with digital technology

One thing to keep in mind once you are ready to start your
workshop, is that young people’s response to digital technology
might vary from one individual to another, and that your plan
might need to be adjusted during the week or even during the
workshop itself.

There are two very important notions to keep in mind when
trying to engage young people with digital media:

1 Putting young people’s interests first
Young people’s interests are at the centre of the workshop and
their creativity will necessarily come from their desire to interact
with technology. For that reason, consulting young people and
making sure that the workshop results from what they have
asked for as much as possible is crucial. In the same way,
throughout the whole workshop, it is better for young people to
engage as much as possible in the completion of their project.
Thus, however tempting it is to take the mouse or the camera
and do something for them, it is better if leaders manage to

touch the mouse or the equipment as little as possible.
Sometimes, showing how to do something is necessary, but
then it is important to make sure that whatever has been
shown is deleted and that the young person tries doing it
themselves, however difficult it might be.

Also, some young people are less attracted by digital technology
than by singing or acting, and it will be tempting for them to ask
the leaders to hold the camera, or record their voices while they
perform. If the workshop is creating through digital technology,
leaders will need to engage these young people with the
equipment as well as the performing aspect, and thus help
them explore a new aspect of their creativity. A way of doing
that for leaders, without forcing young people to do what they
want, is to stay away from the equipment at any rate, and soon
enough young people who like performing will feel one of
them has to do the recording or shooting to allow them to
watch their performance. Leaders can agree with young people
to allow for a rotation in the performance/recording processes
for instance, and often young people will become happier to
handle the equipment once they have been shown and feel
confident when using it.

2 Combining Structure and Flexibility:
Preparation and Monitoring

Structuring your workshop in a certain way during preparation,
even though it can’t answer every young person’s desire or need,
is usually a good way of enhancing young people’s creativity.
Indeed, basing a workshop solely on what young people want
to do can limit their perspective on a particular project and can
often be very difficult to handle for the length of the whole
programme.
As for any other creative workshop, the structure can vary from
one group to another. If you don’t want young people to start
playing games on the computers, it is important to plan activities
that change every 1/2 hour for instance, and to make sure that
each young person is actively engaged at all times.
For instance, when planning a DJ workshop10, I made the mistake
of thinking that a group of 5 young people would be happy to
hover around the turntables and take turns while being introduced
to how they work. Since only one of them could be actively
engaged on the turntables at a time, while the others watched,
after 5 minutes 3 young people had wandered to computers
and cameras, trying to use them. I hadn’t planned any side
activities for that hour but had to adapt and make sure everyone
was happy by generating activities on the equipment young
people had naturally been drawn to.

This is where flexibility becomes a form of monitoring: record
these adjustments and make sure that the rest of the workshop
takes them into account, no matter how much it alters the original
structure. A short consultation between Youth Workers after
each session allows for efficient monitoring and can contribute
to the success of workshops.

10 SWICN IntelComputer Clubhouse and Donore Avenue Youth Services,
February–May 2004
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Because young people usually learn better when actively
engaged in a process, it is better not to rely on a structure
where 2 young people must share a computer, since the one not
holding the mouse might get bored (and become disruptive).
However, if it turns out during the workshop that 2 young people
are happy to work together on a project and are actively engaged
in a task, sharing one computer, it can be very positive for their
creativity to allow that and shows real teamwork through peer
consultation.
This is why flexibility within structure is so important. While
structure will channel and guide young people through the
exploration of their creativity, flexibility will allow them to
evolve within that loose frame and develop their own creative
projects.
Even if it turns out that young people are not receptive to the
structure you had decided on and you have to adapt to the group
during the workshop, keeping that structure in the background
can be a great resource when things start getting a bit loose
and you need to refocus everyone.

Session 1: the group need to decide on a story for the video 
and to start working on the storyboard.

You want to put young people’s interests first and therefore 
plan to start by asking them if there is something they 
would particularly like to make a video about. Because they 
might just not say anything, you will have prepared a number 
of suggestions to help them (friends, schools, family, hobbies...).
You know some young people might not dare to speak up 
and so have prepared bits of paper and pens for everyone to 
put their ideas down anonymously. In case it is still difficult
to get an idea of a story they would like to use, you will have 
prepared a number of suggestions on genres (horror story,
gang story, comedy, love story). You will also have 3 or 4 possible
story starters ready in case they find it hard to find inspiration.
It might turn out that the group is divided around two 
particular stories. Rather than imposing one story and one 
group, it is be better to adjust to young people’s wishes and 
plan for 2 videos instead of one. The smaller the group, the 
more multitasking young people will have to do, so it can be 
a good thing in itself.
You might need to adjust in terms of logistics and use of 
equipment, but by rotating and with a bit of imagination you
should be able to make sure everyone is engaged in a task 
even if the original structure of your workshop has changed.
If all young people have decided for the project they’re working 
on, they will feel more committed to its completion and the 
rest of the workshop will gain from it, as well as the creative 
value of the final result.

Also, flexibility may be needed half-way through the workshop.
According to young people’s response to engaging in a variety
of activities, you can decide  whether to swap groups or to keep
the same structure. Some young people will respond extremely
well to the concept of teamwork, and will be happy to dedicate
themselves to doing nothing but taking pictures, shooting a
film, or designing a cover. They can then call themselves
‘Photographer’, ‘Cameraman’, ‘Graphic Designer’, etc. Other
young people will be happy to try everything and feel they
were engaged in each step of the creative process.

With this flexibility in mind, it will be necessary to keep the
backbone structure of your workshop in the background, for
instance too much time has been spent shooting new scenes
and young people need to start editing in order to have a
finished project at the end.
Also, the mood or enthusiasm of a group for a project can
change from one week to the other, and that’s where flexibility
reaches its limits. With a time frame in mind and the desire for
a completed project, it is a bad idea to change the whole story
and start shooting again. Where creativity is concerned, and
especially when ideas coming from young people are faced
with the technical challenges of digital media, young people
can feel they will never manage and lose interest in the project.
In that situation, structure is necessary to refocus the group
and give encouragement (for instance by showing an example
of a completed project, and how great it looks when finished,
or by helping them finish parts that prove to be technically
very difficult).

1.2.3. Evaluation : degree of learning and engagement by 
young people

As with any other programme, evaluation is necessary in order
to draw conclusions on the workshops, to enhance successes
and avoid repeating mistakes. With some groups, the most
important and often difficult task is to ask young people what
they thought about the workshop. Each Youth Project will have
their own evaluation methods, either through meetings, informal
discussions or games.
As far as digital creativity is concerned, it can be useful to keep
in mind a number of aspects that can help evaluate the success
of a workshop, on top of the usual evaluation questions used
for other programmes:
The learning aspect and its possible difficulty can be an obstacle
to young people’s enjoyment of a particular activity. Organizing
your evaluation around a session where young people look at
the results of the workshop with you (possibly photographs of
them that you took over the weeks of the workshop) can help
young people express how they felt about specific activities.
You can tailor questions to the objectives you set for a workshop,
and see if in young people’s eyes these objectives have been
attained; you might find an interesting discrepancy between
your evaluation and theirs.

EXAMPLE: MONITORING A DIGITAL 
VIDEO WORKSHOP

9PART 1: ORGANIZING SHORT-TERM CREATIVE WORKSHOPS 
WITH DIGITAL TECHNOLOGY



10

Example of questions for an evaluation of a Graphic Design
workshop ‘Make your own Tee-Shirt’.
Context:

It is the last session and after having finished the project, all
participants looked at the final product. Cakes and drinks are
served to celebrate and it is time for an informal evaluation,
since that particular group has difficulty responding positively
to formal meetings. During the preparation of the workshop,
the objectives set were:

• to offer young people an enjoyable first contact with creativity 
through digital media

• to increase young people’s self-confidence through a creative
workshop

• to encourage team work and peer education in that group
• to create a real desire in all or in some young people to do 

more creative workshops using digital technology
• to create a real desire in all or in some young people to learn 

more about the equipment and software.

Youth Workers have printed out examples of each young person’s
work and they start a one-to-one informal evaluation while
looking at them. For that workshop, they have in mind the 
following questions:

• Which one is yours / did you work on? (Among the pictures 
laid out on the table/hung on the walls) 
(evaluating if the young person enjoyed working on the project)

• That’s a great picture, was it fun to do? Did you enjoy doing 
it or was it a bit boring?
(evaluating the learning process and relation with technology)

• That’s a big piece of work, did you find it difficult?
• What bits did you find most difficult?
• Did someone help you on those difficult parts or did you 

manage on your own?
(evaluating the degree of help by staff by peers)

• Do you think it would have been easier if you had had more 
help/time?

• Were you working with someone in particular on that
project? An leader? A friend?
(evaluating team work)

• Did you enjoy working with other people on that project? 
How did they help you/you help them? Do you think it was 
useful or would it have been the same/better if you had 
done it on your own?
(evaluating if the young person remembers what s/he learnt
during the workshop)

• How did you manage to put that effect on your picture? 
What package did you have to use for that? What about this 
colour here? (etc...)
(evaluating the first contact with digital technology)

• Was there anything that you found easy to do on that project?
• Was it too easy? Boring sometimes?
• Do you think computers are easy?
• Would you like to do another workshop with computers? 

Would you like to do it with the same package or would you 
want to try something new? Anything in particular you’d be 
interested in, video, paper mache, plasticine...?

If the evaluation by young people is very negative, it can be
useful to try and see why the workshop hasn’t worked.
Workshops around digital technology can often face difficulties
if there are too many young people for too little facilitators, or too
little computers, insufficient preparation (not enough activities
planned), lack of needs assessment (young people actually
don’t like the theme of the workshop), tensions within the
group, etc.
Sometimes trying to get more feedback on the workshop after a
couple of weeks have passed can also be useful if you are surprised
at the results of the initial evaluation, for various reasons
(desire to be nice to you or the opposite, bad day for some of
them...)
Once you have done your evaluation, you can start thinking of
a good way of following up this workshop.

PART 1: ORGANIZING SHORT-TERM CREATIVE WORKSHOPS 
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If young people gave a positive evaluation of the workshop, it
would be a shame not to try and follow up with more workshops
using digital technology.
Indeed, as anyone who tries to learn about computers will find,
they will usually forget what they have learnt if they don’t use
it regularly.
One-off workshops may be a very good way of introducing digital
media in the shape of a taster, but where possible, following up
is the best way for a Youth Project to ensure young people
build their knowledge of technology. This knowledge will
broaden their horizons towards more creativity with digital
media and will be undeniably useful in their future lives.
As with any other art form, young people will be able to
express their creativity better as they acquire more technique,
which is done through practising and building knowledge.

Also, it is important for a Youth Project to be aware of the 
commitment involved in long-term programmes around digital
creativity, in terms of staff training, resources for creative work-
shops, and equipment maintenance.

2.1. Following up after a creative digital media workshop

There are several ways of following up after a creative digital
media workshop.
One is to organize another workshop, or series of workshops.
Another is to give young people free access to computers in the
form of a regular “creative drop-in”, during which they do not
have unlimited access to the internet or the opportunity to
play computer games, but can work on their own projects. Both
approaches can also be used at the same time.

2.1.1. Using a workshop-based structure

A Youth project may decide to follow up on a successful digital
workshop with other workshops rather than a free access 
‘creative drop-in’ if their groups work better in a structured
environment.
Indeed, in many cases, children up to 12 years old prefer workshops
and guidance to informal access to computers. On the other
hand, teenagers are often happier when given free access to
computers to create individual projects they have chosen.
When this is the case however, Youth Workers can decide these
teenagers also need more structured workshops in order to discover
new aspects of digital technology and not always create what
they know already without any challenge.
Because teenagers tend to have more definite ideas about what
they do and don’t want to do, a digital creativity workshop with
teenagers might require more flexibility than one involving
children for instance.
When planning follow up workshops around digital creativity,
it is important to combine two aspects that can help making
them successful:

- Introducing new elements

When planning for a follow up workshop or a series of workshops,
there should be a new creative dimension, in order to challenge
young people, enhance their creativity and avoid boredom.
It should at least be a new theme, and where available the
addition to the workshop of a new piece of equipment (camera...),
of software (animation...), or a new art form (paper mache, clay...).

- Building on young people’s knowledge

However, in order to allow young people to be more creative and
to use and build on the skills they learnt during the previous
workshop, it is important to start the workshop with activities
involving the software and/or equipment you used previously.
If your first workshop was successful, young people will often
remember what they learnt (with some help at the beginning)
and will be able to transfer their skills to other contexts, to work
on new themes or to create new projects. Once they have started
with these acquired skills, it is then possible to introduce a new,
more challenging dimension to the workshop, both technically
and creatively, either through a new task on the same package,
or the discovery of a new one (e.g. going from still picture editing
to picture animation).

Example:

During the ‘Make your own Tee-Shirt’ Workshop, young people
have learnt the basics of graphic design, how to draw on the 
computer, how to edit a picture on whatever package the 
workshop used.

A follow up to that workshop can be an art workshop like 
‘Sweet Heroes’, where the new dimension of contemporary 
art and making paintings with food allows young people to 
practise what they learnt while making a Tee-shirt in a new 
context. They can start by editing pictures on the computers,
maybe with a number of constraints that will offer a new 
challenge since they are already familiar with the package.
Then they can edit their pictures on paper, take photographs,
and do more image editing with their work on the computer.
For those who are learning quickly, animating with 
Powerpoint or Flash is also possible.

Another possible follow up is a workshop starting with graphic
design that either brings a new package as for example the 
Workshop ‘Litter Awareness in your area’, where young people
start by editing pictures, drawing, etc, and then discover 
animation with Powerpoint or Flash for their CD-ROM.

PART 2: LONG-TERM LEARNING 
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2.1.2. Using a ‘creative drop-in’-based structure:

While workshops allow for team work, adequate challenging of
young people and a completed project at the end, among other
things, computer drop-ins allow for more freedom in the choice
of project and in the creative process itself. They are also often
challenging when young people want to do something that requires
them to learn more skills, and for that reason it is important
that facilitators are realistic when running such sessions.

What does a Youth Project need to open a ‘creative drop-in’?

- A weekly slot, ideally as many as possible during the week for
the same young people. As in the case of workshops, the 
more time that elapses between sessions, the more difficult
it will be for young people to remember what they have 
learnt. Also, in the case of a “creative drop-in”, it can be more 
difficult to keep the creative momentum for a particular project
if too much time elapses between sessions.

- A facilitator, ideally one for 2 or for each youth.
- One computer or piece of equipment per young person.
- A creative package installed on each computer.

Each Youth Project can then design the ‘creative drop-in’ that suits
the community where it is based. If the facilitators are not familiar
with a particular piece of software, they can run a ‘creative
drop-in’ limited to a number of tasks for which they can offer help.
They can also encourage young people to discover a package
and teach themselves it if they want to. The young person can
then show facilitators and other young people how it works,
thus increasing their self-confidence and helping to increase
the possibilities of the drop-in.

Example of a ‘creative drop-in’ session:
Context:

You’ve decided to open a ‘creative drop-in’ for three groups 
of young people who attended a taster workshop around 
digital creativity and showed great interest in digital media.
You have targeted 2 groups of girls and 1 group of boys, all 
teenagers in order to go against prejudices and show young 
people that activities using computers are suitable for both 
sexes.

There are two facilitators who know the software, and two 
youth leaders who aren’t familiar with the software available.
Eight young people turn up, when you had only planned for 
six, since you have six computers. However, you think it’s a 
good sign and don’t want to turn them away:
- Ciaran and his two friends want to make a tee-shirt

with a picture of themselves on their favourite football 
players

- Sarah wants to do some music
- Siobhan brings two friends with whom she wants to 

make a music video featuring a song they have written 
together.

- John wants to draw a Manga11 and edit it on the computer.

In order to make the best use of resources available, you can 
encourage one leader to help Ciaran and his friends take pictures
of themselves with the digital camera and remember how to
download them (they learnt how to download pictures during
the taster workshop). The second leader can help Siobhan 
and her friends prepare their music video: draw a story 
board, plan costumes, become familiar with the digital video 
camera. They won’t need a computer today since they need 
to finish the planning and start the shooting of their video 
before they can start editing on the computer.
One facilitator can help Sarah get familiar with the music 
software, and while she listens to loops11 and chooses some 
she likes, the facilitator can help Ciaran and his friends with 
the editing of their pictures.
The other facilitator can help John scan his drawing onto the 
computer and edit it with a Graphic Design software.

10 Japanese comic book

PART 2: LONG-TERM LEARNING 
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2.1.3. Showcasing Young People’s Work

As for any creative project, the showcasing aspect is a great
incentive for young people to participate, as well as a very good
way for a Youth project to communicate with the community
within which they are working.
On a local level, exhibitions in the Youth Project premises can
be displayed using Powerpoint presentations or animations on
computers, and in that case having sound files playing, music
or recorded voices of young people describing their projects,
can bring a new dimension to an exhibition.

In premises without computers, it is always possible to print
out extracts of a project as well as pictures of the process of
the workshop itself, i.e. young people planning and working on
their projects.

In communities where such exhibitions have very low attendance
levels from parents, it can be a good idea to “bring the technology
into the community” instead of the other way round:

In the above picture, taken in School Street flats, Dublin, in
December 2003, young people’s work (after a series of workshops
in the SWICN Intel Computer Clubhouse) is projected onto a
wall in the flats.
For that projection, I bought a piece of cheap linoleum whose
white side I used as a screen (water- and wind-proof). I hired a
laptop and a projector; School Street Youth Club gave me the use
of a plug in their Centre to plug them into, and youth workers
helped monitor the projection onto the wall.

2.2 How to sustain Youth Projects resources for long-term 
creative digital activities?

2.2.1. Staff training

As stated above, digital creativity is a whole new area for a
Youth Project to explore, and by its very nature it usually needs
commitment as far as getting familiar with the equipment and
software are concerned.
Managers of Youth Projects need to free up time for youth workers
to either get trained or train themselves on new packages.
A number of “made to measure” tutorials for self-training and
relevant to the workshops detailed below are available in PART
4. More tutorials can be downloaded free of charge from the
internet (see the Resources Section, PART 5).
It is also possible for a number of Youth Projects to gather
resources and organize training for Youth Workers together.

How to sustain resources for staff in terms of project ideas for
Workshops?.

Exchanging ideas between Youth Workers and brainstorming is
a good way of getting ideas for innovative workshops.
Also, a lot of non-digital activities like paper mache, murals,
clay, sports, etc, can be used as a starting point for a creative
workshop using digital technology. Indeed, digital technology is
less an activity in itself than a tool to create with, and if youth
workers have a particular project, theme or art activity in mind,
they can often incorporate a digital dimension to them if they
want to.
Thus, manuals dealing with arts and crafts activities can be a
great resource as a starting point, to be combined with a digi-
tal camera, with graphic design, with animation or sound, for
very original projects.

Another possibility is to use local museums as resources for
ideas and creating a partnership with one of them can be a great
way for both sides to discover more of what the other party is
doing in terms of creativity. Indeed, traditional museums are
usually not very familiar with digital art, and it can be interesting
for them to help young people combine fine arts and digital
technology through their exhibitions (and maybe offer a space
to display young people’s work in the museum for a few weeks).
Taking young people to the current exhibition and then running
a workshop that combines an artist’s work, young people’s interests
and digital technology can be beneficial in a number of ways:

• It allows some young people to go to the museum, perhaps 
for the first time.

• It allows young people to see a museum from a different
angle, if they know they are going to be using the same 
technique or theme as the artist on display.

• If young people’s work can be displayed in that same museum,
it shows them that museums are not inaccessible, and this is
usually very beneficial for their self-confidence.

An example of a workshop using a museum’s exhibition is
detailed in PART 3: ‘Sweet Heroes’ (a workshop organized with
the help of the Irish Museum of Modern Art in Dublin).

PART 2: LONG-TERM LEARNING 
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A number of websites can also be used for inspiration, as
detailed in the Resources section of the Appendix.

2.2.2. Equipment maintenance

Making sure all computers are working and are reliable for the
length of a workshop is often a concern for youth workers who
want to run creative digital workshops. It is often possible to
take a subscription for maintenance when buying a number of
computers. Otherwise, as for training issues, a number of projects
can put resources together to share maintenance costs.

If staff want to get familiar with the computers themselves and
not just the packages, they can find tutorials for Windows on
the internet and help for trouble-shooting (see the Resources
Section, PART 5).

PART 2: LONG-TERM LEARNING 
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The following workshops follow an order of increasing complexity
and can be organized in that order, to allow for progression.
These workshops are only examples, the timeframe for sessions
and the organisation of groups are flexible and depend entirely on
Youth Workers’ knowledge of what will work best with their groups.
Within most groups, the pace will vary, and therefore it is good
to plan something to do for those who will have finished quickly
(either another activity or helping other young people).
Although these workshop plans will appear to many to follow a
very slow pace, experience has shown that when young people
are not very familiar with technology, a lot of time is spent
explaining, and waiting for facilitators and other young people
to catch up.

Each session is divided into two parts with the idea that attention
spans might be short within some groups, and that a break and
a change of activity every half an hour can be useful in that context.
It is often useful to allocate a computer to each young person
and to open a folder for each of them on their computer. They
will be able to get familiar with the computer they use and will
feel ownership of their folder, where they can save all their
work over a number of weeks.

Lastly, tutorials are provided in PART 4 for each of the following
workshops, and should provide enough information for you to
run the workshops successfully. Although it is not stated in the
description of the workshops, youth workers or facilitators will
need to have trained themselves on the relevant software in
advance to run these workshops as they will be showing young
people how to complete each task during sessions.

PART 3: CREATIVE WORKSHOPS 
USING DIGITAL MEDIA 17



Workshop 1:
‘Make your own Tee-shirt’
(Photomontage: Graphic Design)

This workshop works very well with young people of all ages,
from 9 year-olds on, and can usually be run in four sessions.

What you will need:
• A digital camera (or a traditional camera and a scanner)
• Computers with a Graphic Design package installed (preferably

Adobe Photoshop, otherwise Paint in Microsoft Office)
• An internet connection for pictures of stars, or a bank of 

pictures you’ll have copied to each computer in advance, if 
you only have an internet connection not accessible from all 
computers (other possibility: pictures from magazines and a 
scanner)

• An inkjet printer (and not a laser printer)
• Iron-on transfer paper12

Session 1: Choosing pictures

Part 1:
Young people choose the tee-shirt they want to make: they can
paste their faces onto the body of their favourite singer, football
player, they can be standing next to them, they can put their
bodies onto an exotic landscape, etc. They can also choose not
to be in the picture and combine two pictures of celebrities in
their photomontage.

If there is no internet connection but a scanner, they will need to
bring a picture of the celebrity they chose at the next session.

If there aren’t enough computers for everyone, one group of young
people can use the camera while others search the internet.
They take pictures of themselves, bearing in mind the position
/angle their faces/bodies need to have to be properly pasted onto
the picture they have chosen (if they haven’t chosen a picture
yet, they take pictures from different angles, front and both sides)
When working with teenage girls, it is useful to be aware that
some pictures of female pop singers might be found inappropriate
by parents with the face of their child on it. It is advisable in
that case to ask young people to choose decent pictures of
celebrities and to explain why.

Part 2:
All pictures are downloaded from the camera onto the relevant
computers, scanned from magazines or saved from the Internet.

12 See ‘Materials and Equipment’ in the Resources Section

Session 2: Downloading pictures and pasting from one picture
to another

Part 1:
Young people can now use the computers and look at the two
pictures they have chosen to combine, one of themselves and
the other: a celebrity, a landscape, etc. Some will probably want
to take or choose extra pictures if they’re not happy with their
material.

Part 2:
Once they are happy with their pictures, they can start selecting
the elements they want to use from the first picture and paste
them onto the second picture.

Session 3: Pasting from one picture to another Adding some
Writing

Part 1:
Young people finish pasting elements.

Part 2:
Young people start adding writing onto their Photomontage:
they can choose their font, colour, size of letters etc.

Session 4: Adding some Writing

Part 1:
Young people work more on the writing and add special effects
to their font in Adobe Photoshop, or choose filters in the same
package.

Part 2:
The finished pictures are printed out and hung on the walls for
everyone to see.
Young people will get their tee-shirts when youth workers have
had time to print the pictures on transfer paper and iron them
onto tee-shirts.

Tutorials available for this workshop in PART 4:
Tutorial 1: Paint(Microsoft Office tool): Paste your face
Tutorial 2: Adobe Photoshop: Paste your face

PART 3: CREATIVE WORKSHOPS 
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Workshop 2:
‘Sweet Heroes’
(Contemporary Arts and Graphic Design)

‘Sweet Heroes’ is a workshop which took place in 2004 as part of
the Irish Museum of Modern Art (IMMA) ‘Focus On’ programme13

in partnership with the SWICN Intel Computer Clubhouse,
around the artist Vic Muniz whose work was being shown in
the IMMA at the time.
The workshop was prepared and facilitated by artist Liz Mc Mahon,
a member of the IMMA’s artist panel, Evy Richard, IMMA staff,
Susan Cullen from the SWICN Youth Services and myself.
Volunteer facilitators included Cliona Harmey, Noel Long and
Debbie Jenkinson.
Special thanks to Lisa Moran, Liz Mc Mahon and Evy Richard for
allowing this very innovative workshop to be detailled in this
Resource Pack.

This workshop was organized for young people aged between
9 and 13 years old, but could work with older youth if adapted
to their tastes. Working with food is usually a good incentive
for young people (especially if they are told they can eat it).

What you will need:
• Food that can be used to make pictures: all kinds of sauces,

sugar, pasta, pickles, etc. Choose food with a variety of 
colours in mind, and try to cover at least primary colours 
(blue, yellow and red) as well as black and white.

• Something to apply food with, as a paintbrush 
(we used little stirring sticks for drinks)

• A digital camera (ideally 2)
• Acetate paper14

• Picture editing software (eg Microsoft Paint, Adobe 
Photoshop) installed on the computers

Session 1: Introduction of the artist’s work

Part 1:
Young people are taken to the museum to see the exhibition of
Vic Muniz’s work, i.e. photographs of pictures made with food.
It is also possible for youth workers to organize their own ‘mini-
exhibition’ of an artist if there is no museum around: They can
print out pictures from the Internet (or photocopy pictures
from library books) and hang them on the walls. Young people
can try and guess what food the artist used for such and such a
picture, or what they represent, what other materials he used
when it wasn’t food (rose petals, lead soldiers...), etc.

13 The IMMA’s ‘Focus On’ Programme…
14 See ‘Materials and Equipment’ in the Resources Section

Part 2:
Young people are given food materials and paper and they are
encouraged to experience drawing with food, choosing and
mixing colours.
At this stage, it is interesting to start taking photographs of
their drawings in the making, from the beginning to the end of
the drawing. Animated using Microsoft Powerpoint or
Macromedia Flash software, it will look like they are being
drawn by an invisible hand.

Session 2: Downloading pictures, choosing a hero and taking
pictures of themselves 

Part 1:
Young people download photographs of their drawings from the
camera and put their work in their own folders on the computer.
Youth workers ask them to pick a hero to work on (favourite
singer, football player, actor etc) and to save a photograph of
that hero in their folder, along with a photograph of themselves.
As in the previous workshop, they can scan photographs if they
don’t have access to the internet.
If the internet is only accessible on one or two computers, the
group can be divided between those on the internet looking for
a picture, and those taking pictures of themselves.
In order to get a better result, it is best to take close shots and
portraits of both young people and their heroes.

Part 2:
Groups swap: young people either look for a picture on the
internet or take pictures of themselves and download them to
their folders.

Session 3: Editing photographs

Part 1:
Young people make sure they have downloaded a picture of
their hero and a picture of themselves into their folders. If not,
they finish the previous session.
In order to be able to work on photographs the same way as
Vic Muniz does, youth workers ask young people to edit both
photographs by bringing out contrast and shadows, in order to
enhance each person’s features. They can do that by using
Microsoft Office Paint but can get a better result with Word.
They can also decide to write something on their picture with
Microsoft Office Paint.

Part 2:
Young people finish editing both pictures (their heroes and
themselves) in the same manner.

Session 4: Using acetate to reproduce their photographs with food

Part 1:
Youth workers have printed out colour photographs edited during
the previous session (ideally on A3 paper, to make it easier to
work on). They place a sheet of acetate on top of each edited
picture, and young people can start retracing lines and shadows
with food.
They can decide to try and reproduce the colours of the original
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pictures, or to change them completely for an Andy Warhol15

effect.
As before, try taking photographs of these pictures in the making,
not just the finished product.

Part 2:
Young people finish retracing their first picture. Although there
is usually no need for a change of activity at this point, it is a
good idea to have a break with snacks available in case young
people get hungry handling chocolate and crisps!
Once they have all finished their first picture (they shouldn’t
start the second one until the next session because the food
won’t keep), they can take the colour picture out from under
the acetate sheet and look at the final result (we stopped
everything at that stage to allow everyone to see the removing
of the colour picture).
Young people take photographs of the final result (the acetate
sheet only). These pictures will be the only trace of the work-
shop left, so it can be useful for youth workers to take pictures
as well, in order to make sure they are properly framed and
high quality. The quality should be set to the highest resolution
available on the digital camera, in order to have nice A4 print
outs for a possible exhibition. For this workshop, it is useful to
have several cameras to take as many pictures as possible of
each young person’s work.

Session 5: Using acetate to reproduce their photographs with
food
This task usually takes at least 2 sessions. Since food pictures
can not be kept from one week to another, make sure 1 picture
is made during the first session, and another one made during
the second session, since any unfinished work from the previous
week will have to be done all over again.

Session 6: Downloading pictures and editing them

Part 1:
Young people download photographs taken during the previous
sessions into their folders and put them in order (from the
beginning of the process to the finished product). They can
start editing a version of their finished work with a Graphic
Design package (ideally Photoshop). They can add writing, a
frame around the picture, correct flaws, etc.

Part 2:
Young people finish their picture editing.

The workshop can stop here, but if youth workers want to
show the work, they can add an extra two sessions for a
Powerpoint animation.

15 American artist and filmmaker, 1928–1987

Session 7: Making an animation

Part 1:
Young people insert their pictures into a Powerpoint document
in the right order.

Part 2:
They can start an animation in the form of a quick slide show.

Session 8: Completing the animation

Part 1:
Young people finish animating their pictures: the more pictures
have been taken during the making of a picture, the more awesome
the final effect will be.

Part 2:
Young people can add special effects, writing or sound to their
animation. The end products are shown to the rest of the group.

Tutorials available for this workshop in PART 4:
Tutorial 3: Word: Picture editor
Tutorial 4: Powerpoint clay/picture animation

Ideas for graphic design can also be taken from the following
tutorials:
Tutorial 1: Paint(Microsoft Office tool): Paste your face
Tutorial 2: Adobe Photoshop: Paste your face 

PART 3: CREATIVE WORKSHOPS 
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Workshop 3:
}Record a Single’
(Digital Music)

This workshop can be easily adapted to any group of young
people and any age-group. Depending on young people’s
enthusiasm for music making, it can be made either in 4 or in 6
sessions.

What you will need:
• Pens and flip chart paper sheets
• A microphone that plugs into the computer (usually you 

need a microphone with a walkman-type plug)16.
• Headphones
• A CD burner: most CD players can now read tracks with a 

‘.wav’ or ‘.mpg’ file extension17.

Session 1: Song writing

Part 1:
If necessary, divide young people into 2 groups and start
discussing what type of song they would like to record,
what type of lyrics, etc.

Part 2:
Young people write the lyrics of their song on a sheet of flip
chart paper.

Session 2: Making digital music

Part 1:
With the help of facilitators (to overcome shyness), young people
record sounds by using the sound recorder on Microsoft Office
Pro -voices, hand clapping, etc. (group clapping, finger snapping
or voices can add a very original effect to a song).

Part 2:
While playing the sounds previously recorded (on Windows
Media Player for instance), young people can record their song
with these in the background on the Microsoft Sound Recorder.
Some young people might be very shy and in that case it is
important to give them the opportunity to record the song on
their own, with everyone out of the room. Results for their self-
confidence can be amazing if they are given that opportunity.

16 See ‘Materials and Equipment’ in the Resources Section
17 See Glossary

Session 3: Song recording

Part 1 & 2:
Young people listen to what they recorded during the previous
session and record it again if they are not happy with the results.
Allow some time for rehearsing, an important element for
young people who do not feel at ease with singing out loud.

Session 4: Cover design

Part 1 & 2:
Young people who have finished their song can design their
own CD cover. For that purpose they can use Microsoft Paint or
Adobe Photoshop.
Before printing, they need to measure the dimensions of a CD
cover and check that their image is the right size.

Tutorials available for this workshop in PART 4:
Tutorial 5: Microsoft Sound Recording

Ideas for graphic design can also be taken from the following
tutorials:
Tutorial 1: Paint(Microsoft Office tool): Paste your face
Tutorial 2: Adobe Photoshop: Paste your face 
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Workshop 4:
‘Litter Awareness in your Area’
(Digital Animation, Sound and Design)

This workshop allows for various forms of expression to be
included in the same project and for that reason can suit a
wide range of ages. Such a variety can be useful when dealing
with a particular theme (around social education for instance).
According to the art forms you want to use for your presentation,
this workshop can take between 6 and 10 sessions.

What you will need:
• A digital camera
• Microsoft Powerpoint
• Clay (if you want to add a clay animation to your presentation)
• Art material like paint and pens, as well as a scanner 

(if you want to add drawings to your presentation)

Session 1:

Part 1:
Young people discuss a number of themes they can choose
from, and how they want to illustrate them (pictures, drawings,
sound, text, clay animation...). The theme chosen is ‘Litter
Awareness’ in the area.

Part 2:
Groups are formed according to each task to be done for the
presentation. Each group starts working on their task:
• group A write a number of slogans/lines for a song to 

promote litter awareness.
• Group B start making drawings and paintings
• Group C works on a clay animation with a little story around 

litter awareness.

Session 2:

Part 1 &2:
Groups work on their tasks.

Session 3:

Part 1 &2:
• Groups work on their tasks.
• 1 group have finished their task and go on a field trip taking 

photographs of litter in the area.

Session 4:

Part 1 & 2:
• Photographs are downloaded from the camera and young 

people start making slides in Powerpoint.
• Group B’s drawings and paintings are scanned (in the 

absence of a scanner, young people can take photographs of 
them and download them onto the computer, although the 
quality will not be as good) 

• Group C take photographs of their animation with the digital
camera.

Session 5:

Part 1 & 2:
• 1 group makes slides with text and pictures
• 1 group records a sound file (song, words spoken, music etc).

If the animation depicts people talking, it is easier to record 
the sound file while watching the animation, to make sure 
they match.

• 1 group makes the clay animation on slides in Powerpoint
(several series of slides can be made in different Powerpoint
documents, and then inserted in the main presentation later).

Session 6:

Part 1 & 2:
• Groups finish their slides
• Sound files are added to each slide.
• All slides are put together in the correct order in one 

Powerpoint document.
• The presentation runs with the CD playing in the background

Tutorials available for this workshop in PART 4:
Tutorial 4: Powerpoint clay/picture animation
Tutorial 5: Microsoft Sound Recording
Tutorial 6: Powerpoint presentation (text,pictures and sound)

Ideas for graphic design can also be taken from the following
tutorials:
Tutorial 1: Paint(Microsoft Office tool): Paste your face
Tutorial 2: Adobe Photoshop: Paste your face

PART 3: CREATIVE WORKSHOPS 
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The following tutorials were made with: Windows XP, Microsoft
Office Pro and Adobe Photoshop 7. If your computers have earli-
er versions of these software packages, they might not allow all
the commands mentioned in the tutorials.

PART 4: TUTORIALS FOR  
CREATIVE WORKSHOPS

TUTORIAL 1: MICROSOFT PAINT :PASTE YOUR FACE 25

TUTORIAL 2: ADOBE PHOTOSHOP: PASTE YOUR FACE 30

TUTORIAL 3: MICROSOFT WORD: PICTURE EDITOR 36

TUTORIAL 4: POWERPOINT CLAY ANIMATION 38

TUTORIAL 5: SOUND RECORDING 40

TUTORIAL 6: POWERPOINT PRESENTATION (TEXT,PICTURES AND SOUND) 41
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Draw a square around your face with the curser. If you’re not
happy with your selection area, click outside of the square, and
draw it again:

Step 3: Once the picture of yourself is open, click on the select
icon:

Tutorial 1
Microsoft Paint
Paste your face

Step 1: Double click on the pictures you want to use. Once they
are open, click on the editing icon:

Your pictures are now open in Paint, the picture editing package
of Microsoft Office.

Step 2: Click on the picture of yourself (or the one from which
you want to copy something).
If you can’t see it minimize the picture on the screen by clicking
on the white dash in the top right hand corner:
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Step 4: Place the curser of the mouse on the bottom right hand
corner.When two little black arrows pointing at opposite directions
appear, drag it up in order to decrease the size selection area.
Compare with the picture where you want to paste your face
and try and get the right size to make it match.
When the size is right, click on the Edit menu (top tool bar) and
click Copy (or Ctrl + C)

Step 5: Open the other picture in Paint. Go to the Edit menu
and click Paste. Your face now appears in a square. You can
move it around by using the cross arrow.
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Step 6: Go to File and Save As, and change the name of the picture
or add a number, to make sure you can reuse the original picture
if you want to. On this project for instance, I opened the original
picture of The Matrix again after having saved mine under a
different name and I selected Keanu Reeves’ sunglasses with
the square select tool. I copied them and pasted them onto the
edited picture with my face on it:

Step 7: You can now use the tools on the left hand side to edit
your picture. If you want to blur the edge of the square: use the
Pick Colour tool:

Select the Pick Colour tool, and click on the original place on a
spot with a colour you would like to clone. By clicking on that
spot the computer will automatically pick the closest colour in
its range of available colours.
Then select the Paintbrush tool and draw around your face in
order to get rid of the background for the best effect. You can
change the size and shape of the brush by selecting the one
you want at the bottom of the left hand toolbar:
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The Pick Color tool can take some time, since colours chage a
lot on a picture, you will need to pick the colour you want (the
closest to your face usually, so that it blends in) several times if
you don’t want the montage to be too messy:

Although it is difficult to make a perfect photomontage in
Paint, it is still possible to make something.

Step 8: You can also draw and add writing onto your picture,
also by using the tools in the left hand toolbars:

To add writing, click on the Text tool:

If you want to have a white square around your writing, make
sure the command Draw Opaque in the Image menu (top tool
bar) is ticked. If you want a transparent background make sure
the Draw Opaque command is unticked ( see the 2 examples of
both types below):
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To change the size and type of your font, go to the View menu
(top tool bar) and make sure the Text toolbar is ticked. If it isn’t,
click on it to make it appear. Select your words, and change the
font, size and type to your tastes.

If you want to change the colour of your letters, make sure the
Colour box command is ticked in the View menu.
If it isn’t ticked, click on it to tick it. Highlight your words and
double click on the square with the colour you want in the
Colour box (bottom of the screen). A Basic Colours dialog window
appears, in which you can customize colours if you’re not
satisfied with the ones offered by the Colour box. Otherwise
just click OK.
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Tutorial 2
Adobe Photoshop
Paste your face

Step 1: Open your pictures in Photoshop

• Go into the File menu in the top toolbar, and double-click 
Open.

• In the window that appears, find the folder where you saved 
your pictures and double-click on one of your pictures:

Repeat the operation for each picture you want to work with.
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Step 2: select your face:

Click on your picture (the blue top stripe on the picture window
becomes dark blue instead of light blue, this means you are
working on this picture. The other pictures in the background
have a light blue top stripe).

To select your face, you have 2 choices:

• If there is enough contrast between your face and the 
background, use the Magic Wand tool by clicking on it:

MAGIC WAND

1. Go into the toolbar on the left on the screen, and click on 
the Magic Wand.

2. Click on your face once with the Magic Wand: an area of 
your face is selected:

3. Press the Shift Button ( _ under the Caps Lock) and keep 
clicking on your face (never release the Shift Button while 
doing that) until all the little dots on your face are gone, and 
you have a dotted line around your head:

• if you find it is not working with the Magic Wand, use the 
Lasso tool by clicking on it:

LASSO

1. Go into the toolbar on the left on the screen, and click on 
the Lasso.

2. Trace a circle around your head, as close as possible, but
even if the background is still visible it doesn’t matter.

3. Go into Edit/Copy.
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4. Go into Edit/Copy.

5. Click anywhere on the other picture (where you want to 
paste your face; blue stripe becomes dark blue, the picture 
comes forward):

6. Go into Edit/Paste.Your face comes up but it is probably 
not the right size and not in the right place.

4. Click anywhere on the picture where you want to put your 
face (blue stripe becomes dark blue, the picture comes for
ward).

5. Go into Edit/Paste.

6. To get rid of the background around your head pick the 
Rubber tool:
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Step 3: change the Size and Colour of your face:

Go into Edit/ Free Transform (check you are working on the
right layer containing your face): a little square appears around
your face.
Use the mouse to drag the little corners and change the size of
your face. To move your face, position the curser on your face to
make it become a little black arrow. When it is the case, click
and drag your face where you want it to be:

Once you are happy with the size of your face, press Enter.

You can change the size of the Brush on the top left of the 
screen, by clicking on the little arrow near Brush. Now you 
can rub the background around you head.

Your picture is probably not the right size and not in the right
place.
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Step 4: adjust colours:
Tip: Make sure the layer18 of your face is selected in the Layers’Window.
To open the Layers’ Window, click on the Window Menu, Layers:

Click on Image in the top toolbar.

18 Each time you paste a picture or insert text, they are added in the shape of 
a layer onto the background you are working from.

To Change an image into black and white:
Choose Image, Adjustments, Hue/Saturation

Under Saturation, move the little arrow left to get a Black 
and White image:
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To Change the colours:
Choose Image, Adjustments, Color Balance.
You can play with the three arrows to change the colour of
your face.

Change the light on your face:
Choose Image, Adjustments, Brightness/Contrast

Step 5: Before printing: view and change the print size

Choose File > Print with Preview
You can now adjust the size of the picture by using the little
squares at the corners, or by ticking the Scale To Fit Media box:

If you want your picture to be printed in Landscape format,
click on Page Setup – in the top left hand corner of the Print
Window – and tick the Landscape box. You can then click OK
and Print.

PART 4: TUTORIALS FOR  
CREATIVE WORKSHOPS 35



Tutorial 3
Microsoft Word
Picture Editor

Step 1: Insert a picture

Open a Word Document. In the Top toolbar, click on Insert,
Picture, From File...:

A window opens displaying your folders, find the picture you
need and double-click on it (or click on Insert):

When your picture opens in your document, a Picture editing
window comes up at the same time unless it is already in your
toolbar (you need to click on the picture to see that window
come up):
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Step 2: Edit a picture in Word

Once your picture is open, you can start using the Picture editing
toolbar to make changes in colours and shades.

• Enhance Contrast:

Click on the following Icon for more contrast:

For a workshop like the “Sweet Heroes” one, you can use that
tool to its maximum:

For a Black and White version:
Click on the icon Color:

Select Black and White:

You can also play with the icon Color for more effects
(Grayscale and Washout).

Change the size of the picture:
To change the size of your picture, use the little black squares
that come up on the sides of the pictures when you click on it.
Click on them and drag them to the needed size.
If you want to make sure all your pictures are the same size,
click on the icon Format Picture:

In the window that comes up, click on the Size Thumbnail:

By changing the figure in the Height and the Width box, you
will change the size of each picture precisely.
To keep proportions, make sure the Lock aspect ratio box is ticked.
As you will find out by clicking on the other icons in the Picture
Editor window, you can also change brightness, crop your pic-
ture, rotate it, set a transparent colour etc.
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Tutorial 4
Powerpoint
Clay Animation

Step 1: Make an animation with your digital camera: using
clay/plasticine:

First, make your characters from clay or plasticine and your
background (you can use printed out pictures or paint a background
on cardboard), then you can start taking photographs:

• make sure the camera is rested on a tripod (or a book), and 
that it doesn’t move too much from one picture to the other.

• before shooting the whole animation, it can be useful at the 
beginning to experiment with the speed and the way the 
characters move (for instance, if you make very small changes 
between each still, the animation will be more precise but
slower).

• the animation will look more realistic if the arms and legs,
heads and mouths of the characters also move, although it
takes a bit more time.

• if young people are getting impatient the first time, it can be
useful to take 10 pictures only and show them what it looks 
like on Powerpoint straight away. It will give them an incentive
to be a bit more patient.

Step 2: Insert pictures into Powerpoint
• Download pictures onto the computer.
• Open a new Powerpoint document: in the top toolbar go into

the File menu, click New.
• In the top toolbar: go into the Insert menu, go to the Picture 

menu and leave the curser on the little black arrow. A new 
menu comes up, click From File...

• A window opens with folders, find the folder where your 
pictures are downloaded:

• Double-click on the first picture of your animation.
• It comes up on your Powerpoint slide
• You can change its size by dragging the little circles on the sides:

• Once you have adjusted the size of the first picture, go into 
the Insert menu and click on New Slide (or Ctrl+M).

• Repeat the same steps for each picture (in the right order) on
each slide.

Your Powerpoint document should look like the picture bellow
(this is a Windows XP version):
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Step 3: Adjust the animation settings

• Go into the Slide Show menu and click Slide Transition.
A window opens on the right hand side of the screen:

• Make sure the settings of the Slide Transition are as on the 
picture above:
No Transition
Speed: Fast
Sound:(No sound) (you can add sounds but they will delay 
the playing of the next slide, making the animation very slow,
and they will only last for the slide in which it was added).
Advance slide: Automatically after 00:01 (this is the fastest
an animation can be in Powerpoint, but you can also slow it
down if needed).

Now click on Slide Show to see your animation. Once the settings
of the animation are saved, you can add slides and pictures to
the animation without needing to reset your slide show.

To get out of the Slide Show, press Esc.
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Tutorial 5
Sound Recording

It is possible to record sound from Microsoft Office, with a
microphone (this depends on what version you have and what
you computer’s specifications are).

Go into (All) Programs, Accessories, Entertainment, Sound
Recorder:

A window comes up with sound recording buttons.Your microphone
should be plugged into your computer (you can use a microphone
with a small plug as used for a walkman19).

Buttons work like on a traditional tape recorder: click on the red
circle to record, etc:

19 See ‘Materials and Equipment’ in the Resources Section

Once your sound is recorded, you can save it as a ‘.wav’20 file,
which means you will be able to listen to it on the computer
and on most CD players puchased recently 
To do so, click on File, Save, and save it into the right folder.

20 See Glossary
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Tutorial 6
Powerpoint Presentation
(text, pictures and sound)

Step 1: Insert Text
• Open a new Powerpoint document. In the top toolbar go into

the File menu, click New. A Powerpoint document opens – a 
window sometimes comes up to offer you a choice of lay-outs
for your first slide (blank slide, 1 or 2 text boxes). Whatever 
you choose, you will be able to delete and insert text boxes 
anyway by using the Delete key or the Insert menu in the Top
Toolbar (Insert, Textbox):

By Clicking in Text boxes, you can type text, change fonts,
sizes and colours like in a Word document.

Step 2: Choose a design for your slides

• Click on the Format menu in the Top Toolbar and select Slide 
Design. On the right hand side of the screen a window 
appears with a number of possible design templates:

If none of the templates suit you, you can customize your 
animation. Click on Format and select Background. With 
More Colors... option, you can pick a bigger range of colours.
You can also use the Fill Effects... option to add effects to your
background:

Once you are happy with the colour you have picked, click on 
Apply or Apply to All if you want the same background for 
every Slide. If so, each New Slide you will open will have that
background colour.
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Use a picture as Background: Click on Fill Effects. A window 
comes up -click on the Picture Thumbnail. Click on the Select
Picture button and find the picture you need in your folders.
Click OK, then click either Apply or Apply to All (if you want
the same picture on all slides):

Step 3: Make all the slides for your presentation

To insert a new slide (that will automatically be inserted after
the slide you are working on), click on Insert (Top Toolbar
menu), New Slide.

By inserting text boxes, you can add text.
You can also insert pictures:

• In the Top Toolbar: go into the Insert menu, then go the 
Picture menu, leave the curser on the little black arrow: a 
new menu comes up, click From File...

• A window opens with folders; find the folder where your 
pictures are:

• Double-click on the picture you need.
• It comes up on your Powerpoint slide
• You can change its size by dragging the little white circles on 

the sides:

• Repeat the same steps for each picture on each slide.

If you want to insert a Clay Animation, just use the TUTORIAL
‘Powerpoint Clay Animation’. Add slides in the middle of your
presentation for the Clay Animation to play. You can then add
slides after the animation for the rest of your presentation.
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Step 4: Animate your presentation

Animate text:
Once the content of your slides is ready, you can add special
effects that allow your text to appear on the screen line by line,
or letter by letter for instance. Click on the Slide Show menu
and select Animation Schemes. A window appears on the right
hand side of the screen with a choice of shemes.

Make sure the AutoPreview button is clicked; it will allow you
to preview the animation when you click on it. If you want one
of these schemes to apply to all your slides, click on the Apply
to All Slides button at the bottom. The Slide Show button will
allow you to watch your slide show; to exit just press the Esc key.

If you want more effects, click on Slide Show, then Custom
Animation, a window comes up on the right hand side of the
screen.
In order to add an effect to a title, select the text and click on
the Add Effect button. A number of options come up. If your
AutoPreview button is ticked, you will see the preview of each
effect when clicking on it.

You can add effects to the entrance of the text and to the exit.
Once you have given text an effect, a little box with the text
appears in the right hand window. You can change these effects
by clicking on the Change button at the top of the window. You
can choose and change settings for an effect by clicking on the
little black arrow on the right hand side of the box:

Add sound:
You can add sound to your slide show, either Powerpoint
sounds or your own (to record sound see TUTORIAL Sound
Recording). However, the sound you add will only be for one
slide, and the slide will last as long as the sound file does.
Therefore, you need to make sure that a sound file doesn’t slow
down your presentation, and that it matches with the slide
during which it will play.

To add sound to a slide, click on Insert, Movies and Sounds,
Sound from file / or Record Sound if you want to record at the
same time (you will need a microphone) / or Sound From Clip
Organizer if you want pre-recorded Powerpoint sounds.
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Once you have selected your sound file, a little speaker appears
on the slide. You can listen to it by right-clicking on it and
selecting Play Sound, or edit it by selecting Edit Sound.

Customize transitions:
You can alsoadd special effects to your slide transitions: click on
the Slide Show menu in the Top Toolbar, Slide Transitions.
A window opens on the right hand side with a choice of transitions:

You can then choose the transition you want for each slide or
the same one for all of them if you click on the Apply to All
Slides button.
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1. QUESTIONNAIRE FOR YOUTH WORKERS

YOUR YOUTH PROJECT AND TECHNOLOGY
A questionnaire for Youth Projects having computers accessible to young people

Question 1: How many computers accessible to young people do you have?

Question 2: Do you use them with young people? Yes No 

If you ticked Yes, how do you use them? 
(e.g. CV writing, game playing, research on the internet...) 

If you ticked No, would you like to use your computers with young people?
Can you please explain why?

Question 3: Would you like to use computers more with young people? Yes No 

If so, what help do you feel you would need?

staff training more software

more computers tips to maintain computers

tips to engage young people with the computers

What other help would you need to use computers with young people?
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2. RESOURCES:
DOWNLOADING AND BUYING SOFTWARE FROM THE INTERNET

2.1 Where can you find software and trial versions downloadable from the Internet free of charge?

• Acid Pro trial version (music):
http://mediasoftware.sonypictures.com/Products/ShowProduct.asp?PID=704

Loops are indispensable to making music with Acid Pro. The package comes with a number of loops already, but more loops can 
be downloaded for free at: http://www.acidplanet.com
To download loops, click on the ‘wav’ option of each loop (.wav is an extension for music files, it is the easiest extension to read 
for most packages). For more loops, you have a number of links indicated on the address given above.
Tutorials available:
• In Acid Pro itself, the menu “Show me how” gives basic tutorials to use Acid.
• on the following website: http://mediasoftware.sonypictures.com/download/Step2.asp?DID=491

(Screenblast Acid Manual- English)

System requirements:
300 MHz processor*
Windows-compatible sound card
CD-ROM drive
Supported CD-Recordable drive (for CD Burning)
64 MB RAM (128 MB recommended)
60 MB hard-disk space for program installation
Microsoft Windows 98SE, Me, 2000, or XP
DirectX 8.0 or later
Internet Explorer 4.0 or later 
* 400 MHz processor for video scoring.

• Adobe Illustrator trial version (graphic design):
http://www.adobe.com/products/tryadobe/main.jsp#product=39

System requirements:
WINDOWS:
Intel® Pentium® III or 4 processor 
Microsoft® Windows® 2000 with Service Pack 3 or Windows XP® 
192MB of RAM (256MB recommended) 
470MB of available hard-disk space 
CD-ROM drive 
For Adobe PostScript® printers: Adobe PostScript Level 2 or PostScript 3TM

MACINTOSH:
PowerPC® G3, G4, or G5 
Mac OS X v.10.2 through v.10.3 
192MB of RAM (256MB recommended) 
470MB of available hard-disk space 
CD-ROM drive 
For Adobe PostScript® printers: Adobe PostScript Level 2 or PostScript 3TM
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• Adobe Photoshop CS trial version (photo editing & graphic design):
http://www.adobe.com/products/tryadobe/main.jsp#product=39

System requirements:
WINDOWS:
Intel® Pentium® III or 4 processor 
Microsoft® Windows® 2000 with Service Pack 3 or Windows XP® 
192MB of RAM (256MB recommended) 
280MB of available hard-disk space 
Color monitor with 16-bit color or greater video card 
1,024 x 768 or greater monitor resolution 
CD-ROM drive

MACINTOSH:
PowerPC® G3, G4, or G5 processor 
Mac OS X v.10.2 through v.10.3 
192MB of RAM (256MB recommended) 
320MB of available hard-disk space 
Color monitor with 16-bit color or greater video card 
1,024 x 768 or greater monitor resolution 
CD-ROM drive

• Adobe Premiere trial version (video editing): for Windows
http://www.adobe.com/products/tryadobe/main.jsp#product=39

System requirements:
WINDOWS:
Intel® Pentium® III 800MHz processor (Pentium 4 3.06GHz recommended) 
Microsoft® Windows XP® Professional or Home Edition with Service Pack 1 
256MB of RAM (1GB or more recommended) 
800MB of available hard-disk space for installation 
Microsoft DirectX-compatible sound card (multichannel ASIO-compatible sound card for surround sound support recommended) 
CD-ROM drive 
Compatible DVD recorder (DVD-R/RW+R/RW) required for Export to DVD 
1,024 x 768 32-bit color video display adapter (1,280 x 1024 or dual monitors recommended) 
For DV: OHCI-compatible IEEE 1394 interface and dedicated large-capacity 7200RPM UDMA 66 IDE or SCSI hard disk or disk array 
For third-party capture cards: Adobe Premiere Pro certified capture card 
Optional: ASIO audio hardware device; surround speaker system for 5.1 audio playback
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• Corel Painter trial version (graphic design):
http://www.corel.com/servlet/Satellite?pagename=Corel2/Downloads/Home

System requirements:
WINDOWS:
Windows® 2000 or Windows XP® (with latest Service Pack) 
Pentium® II, 500 MHz or greater 
128 MB RAM (256 MB recommended) 
Mouse or tablet
24-bit color display 
1,024 x 768 or greater monitor resolution 
CD-ROM drive 
380 MB of available hard disk space 

MACINTOSH:
Mac® OS X (version 10.2.8 or higher) 
Power Macintosh® G3, 500 MHz or greater 
128 MB of RAM (256 MB recommended) 
Mouse or tablet
24-bit color display 
1,024 x 768 or greater monitor resolution 
CD-ROM drive 
395 MB of available hard disk space

• Gamemaker (videogame construction):
www.gamemaker.nl
Tutorials available at: www.gamemaker.nl/tutorial.html

System requirements:
Game Maker runs on the Windows platform, versions 98 SE, NT, 2000, ME, XP (and later). It does require a machine that supports 
3d graphics and has at least 8MB of video memory (preferably 16 MB or more). DirectX version 8.0 or later is required (not included;
you can download it at Microsoft DirectX page:
http://www.microsoft.com/downloads/search.aspx?displaylang=en&categoryid=2)
There are two versions of Game Maker: the free unregistered version and the full registered version.
Free Version
The unregistered version of Game Maker can be used for free. Simply download it at this address, and execute gmaker.exe.
Game Maker version 6.0 (4.0 MB) :
http://www.gamemaker.nl/download/gmaker.exe 

If you have problems with downloading executables, you can also download a zip file containing the program. Unzip it and run 
gmaker.exe inside it to install it. Read the included license agreement before using the program.
Zip version of Game Maker version 6.0 (4.0 MB):
http://www.gamemaker.nl/download/gmaker.zip

These downloads contain a few example games and a small collection of sprites, backgrounds, sounds, etc. If you want more 
resources go to the Resources page:
http://www.gamemaker.nl/resource.html
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• Macromedia Dreamweaver trial version (website construction)
http://www.macromedia.com/software/dreamweaver/?promoid=home_prod_dw_082403

System requirements:
WINDOWS:
600 MHz Intel Pentium III processor or equivalent
Windows 98 SE (4.10.2222 A), Windows 2000, Windows XP, or Windows Server 2003 
128 MB RAM (256 MB recommended) 
275 MB available disk space 

MACINTOSH:
500 MHz Power PC G3 processor 
Mac OS X 10.2.6 and later, 10.3 
128 MB computer RAM (256 MB recommended) 
275 MB available disk space 

• Macromedia Flash trial version (animation):
http://www.macromedia.com/cfusion/tdrc/index.cfm?product=flash

System requirements:
WINDOWS:
600 MHz Intel Pentium III processor or equivalent
Windows 98 SE (4.10.2222 A), Windows 2000, or Windows XP 
128 MB RAM (256 MB recommended) 
347 MB available disk space 

MACINTOSH:
500 MHz PowerPC G3 processor 
Mac OS X 10.2.8 and later, 10.3.4 
128 MB RAM (256 MB recommended) 
280 MB available disk space 

• Paint Shop Pro trial version (photo editing & graphic design):
http://www.jasc.com/products/trialreg.asp?pid=k-psp8-usdir

System requirements:
WINDOWS:
300 MHz processor or faster
Microsoft® Windows® 98SE, 2000 (SP4), ME, XP
256 MB of RAM
500 MB of free hard drive space
16-bit color display adapter at 800 x 600 resolution
Microsoft® Internet Explorer 6.0 or later
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• Quicktime (music and video player)
http://www.apple.com/quicktime/download/

System requirements:
WINDOWS:
A Pentium processor-based PC or compatible computer 
At least 128MB of RAM 
Windows 98/Me/2000/XP 

MACINTOSH:
A 400 MHz PowerPC G3 or faster Macintosh computer.
At least 128MB of RAM 
Mac OS X v10.2.8 – 10.3.x 

• Squeak (graphics and games for children):
www.squeak.org
Tutorials available at: http://www.squeak.org/documentation/

System requirements:
WINDOWS:
Windows 98/95, NT, XP, and CE:
To download Squeak 3.7 for Win 98/95, NT, and XP, You will get a zip archive of all four files needed for Squeak:
ftp://st.cs.uiuc.edu/Smalltalk/Squeak/3.7/win/Squeak3.7-current-win-full.zip
For Windows CE the best choice is to go to Yoshiki Ohshima’s WinCE site:
http://www.is.titech.ac.jp/~ohshima/squeak/WinCE.

MACINTOSH:
MacOS 7.5 through 9.2 Classic, and MacOS X (Carbon and Cocoa)
Squeak 3.7 is available as a bundle of files: Squeak3.7-current-MacOS-Full.sit.:
ftp://st.cs.uiuc.edu/pub/Smalltalk/Squeak/3.7/mac/Squeak3.7-current-MacOS-Full.sit

• The Ubuntu (Linux) community:
www.ubuntulinux.org:

Ubuntu gathers a number of packages for picture editing, sound recording, word processing, etc.

It can be downloaded for free from the above website and it is license-free.

The ‘Shipit’ page also commits to sending you CDs free of charge:
http://shipit.ubuntulinux.org/

System requirements:
It will run on most PCs and Apple Macintosh computers, you just have to click on the relevant link according to your type of 
computer:

• For almost all PCs. This includes most machines with Intel/AMD/etc type processors and almost all computers that run 
Microsoft Windows.

• For Apple Macintosh G3, G4, and G5 computers, including iBooks and PowerBooks.
• For computers based on the AMD64 or EM64T architecture (e.g., Athlon64, Opteron, EM64T Xeon). It is not necessary for all 

(even most) processors made by AMD – only their 64 bit chips.
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• Windows Media Player (music and video player)
http://www.microsoft.com/windows/windowsmedia/mp10/default.aspx

System requirements:
WINDOWS:
Minimum
Microsoft Windows(r) 98, Windows 98 Second Edition, Windows 2000, or Windows Millennium Edition 
Pentium 166 megahertz (MHz) processor 
32 MB RAM 
28.8-kilobits per second (Kbps) modem 
16-bit sound card 
256-color video card 

Recommended 
Windows 98, Windows 98 Second Edition, Windows 2000, or Windows Millennium Edition 
Pentium or AMD Athlon K6 266 MHz processor or faster 
64 MB RAM 
56-Kbps modem 
24-bit true color video card 

MACINTOSH:

• Yahoo pages on Geocities (Website construction):
You can choose between a basic website construction package; ‘Yahoo! Page Wizards’ or a more advanced one 
‘Yahoo! Page Builder’: http://geocities.yahoo.com/ps/learn2/HowItWorks4_Free.html

Tutorials available at: http://help.yahoo.com/help/us/geo/tour/tour-01.html

System requirements:
Geocities website construction all happens online, therefore there are no system requirements to use it.



2.2 Where can you buy software on the Internet?

All software whose trial versions are mentioned in the previous
section can be purchased on the same websites as indicated there.

• Educational games can be bought from this website:
http://familyeducation.com/home/

• ‘Incredible Machines’ by Sierra 
(Creative and Educational game):
can be bought on www.amazon.com
System requirements:
Windows 95/98/2000
Intel Pentium 90MHz processor 
32MB RAM 
50MB hard drive space 
4X CD-ROM

• Microsoft Publisher
(Publishing software: newsletters and websites):
This is an easier tool to design web pages, although it is 
more limited. It can be bough like a lot of other packages on 
Amazon: www.amazon.com

• Microsoft Creative Writer, for under 12s 
(Publishing software: newsletters and websites):
Can be bought on:www.amazon.com, or 
www.shopping.yahoo.com

• Educational games can be found on this website:
http://familyeducation.com/home/

• Video Factory
(video editing):
Can be bought on:www.amazon.com
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3. THEORY AND IDEAS AROUND YOUNG PEOPLE 
AND DIGITAL CREATIVITY

3.1 Theory

Piaget, J:
www.piaget.org

Papert, S:
www.papert.org

Resnick, M, Rusk, N, Cooke, S:
‘The Computer Clubhouse:
Technological Fluency in the Inner City’
http://llk.media.mit.edu/papers/archive/clubhouse/

NESTA Futurelab
Literature Review in Creativity,
New Technologies and Learning
http://www.nestafuturelab.org/research/reviews/cr01.htm

3.2 Ideas for creative projects:

Learning to love you more is a website where artists give 
participants assignments for creative projects (not specifically 
around digital technology, but it can be inspiring):
http://www.learningtoloveyoumore.com/

The Computer Clubhouse network gives links to each 
Clubhouse’s websites, on which you can find examples and 
ideas for creative projects made with digital technology:
http://www.computerclubhouse.org/sattext.jsp#Australia

Lessons and ideas in digital creativity for teachers and youth 
workers:
http://www.youthlearn.org/
http://www.adobe.com/education/digkids/main.html

Inspiration for projects related to arts:

Educational resources for schools and youth projects can be 
found on major museums websites, e.g.:

Metropolitan museum (New York):
http://www.metmuseum.org/explore/museumkids.htm
and:
http://www.metmuseum.org/education/er_online_resourc.asp

Guggenheim museum in New York:
http://www.guggenheim.org/artscurriculum/lessons/start.php

The Irish Museum of Modern Art:
http://www.modernart.ie

Keith Haring’s (American artist) website for kids:
http://www.haringkids.com

4. MATERIALS AND EQUIPMENT

Where can you purchase the following materials and equipment?

Acetate paper: transparent paper, can be found in paper/printing
shops or through stationnary catalogues.

Clay: can be found in arts and crafts shops.

Iron-on transfer paper: can be found through stationary 
catalogues. Using instructions

Microphone: can be found in Hi-Fi and computer shops

Plasticine: can be found in arts and crafts shops
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5. GLOSSARY OF TECHNICAL TERMS

Analog port: port used for traditional non-digital video cameras

Chat rooms: websites through which participants can talk to
each other live. Some child abuse and kidnappings have taken
place after chat room contacts between a young person and an
adult.

Digital Still Camera: unlike a traditional still camera that works
with a film, a digital still camera allows the user to take photographs
and store them onto a memory card. They also allow the user
to download photographs directly onto a computer, usually
through a USB port/connection.

Digital Video Camera: unlike a traditional video camera that
works with a tape, a digital video camera allows the user to
shoot movies and store them onto either a DV memory card
(DV Camera) or a ‘Hi-8’ tape (‘Hi-8’ Digital Camera, or
Camcorder). They also allow the user to download movies
directly onto a computer.

DV Camera: a DV Camera is fully digital and records movies onto
a memory card. Movies can be captured from the DV camera
onto a computer through a firewire port/connection.

File extension: A file extension is made up of letters/numbers
that determine its format. For instance a Word document will usually
have a file extension ‘.doc’ and the full name of a document
called ‘letter’ will be: ‘letter.doc’.A Powerpoint document will
usually have a file extension ‘.ppt’.

• Sound files that can be played from Windows Media Player,
Quicktime21,and CD players usually have the extensions ‘.wav’
or ‘.mp3’.

• Video files that can be played from most computers are 
usually ‘.mov’ for Quicktime and ‘.avi’ or ‘.wmv’ for Windows 
Media Player.

• Image files that are downloaded from a camera usually have 
a file extension ‘.jpg’.

It is possible to change a file extension and thus convert a 
document into a different format by clicking on Save As, and
selecting a different format in the Save As Type box.

File extensions do not necessarily come up on the screen, to
have them displayed when you’re looking into a folder, you
need to go into View in the top toolbar, and click on Details.

Firewire: digital connection that allows the user to download
movies onto a computer.

21 See the Resources Section to download these software packages.

‘Hi-8’ Digital Camera (or Camcorder): a ‘Hi-8’ digital camera
records movies onto ‘Hi-8’ type tapes and can be captured
either through an analog port or through a firewire (digital port).
They can be considered as a cross between traditional video
cameras and fully digital video cameras (called DV cameras).

Loops: in the context of digital music, loops are music samples
usually consisting of one instrument. These can be modified and
combined to make a piece of music, and can serve as background
music to a recorded track.

Macintosh: user interface created by Apple (the two most common
user interfaces are Windows and Macintosh)

Netnanny: a software that will block most websites with
pornographic content: these work by blocking websites 
containing words like “sex”.

Peer teaching: peer teaching is the process through which
young people teach other young people.

Pop-ups (or Pop-up windows): little windows that automatically
pop-up on your screen and can be linked with pornographic
content.

System Requirements: the configuration and the amount of space
available needed to download a particular piece of software.

USB: hard wired connection that allows to download pictures
on both PCs and Apple computers.

Windows: user interface created by Microsoft (the two most
common user interfaces are Windows and Macintosh) and used
on PCs.
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